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Acronyms
CCDA – Climate Change and Development Authority
DIF – Difference
FUNCATE –
GIS – Geographical Information System
INPE – Brazilian National Institute for Space Research
PNG – Papua New Guinea
PNGFA – Papua New Guinea Forest Authority
PRODES –
REDD+ – Reducing Emissions from deforestation and forest degradation in developing countries
including forest conservation, sustainable management of forest and enhancement of forest
carbon stocks
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Preface
Welcome to TerraPNG
TerraPNG is Papua New Guinea’s customised version of TerraAmazon which is an open source
GIS tool developed by INPE for the purpose of monitoring Brazilian Amazon Forest. TerraPNG is
designed to be a multi-user editor of geographic vectorial data stored in a TerraLib model
database. It engages land use and land cover classification tools as well as spatial operations
between vector data, allowing transitions analysis among other applications. TerraPNG keeps
working time records for project control. Its functionalities are extensible through plugins, such as
the already existing TerraImage (PDI) and TerraPrint (plotting).
The source platform TerraAmazon was first developed by INPE and FUNCATE in early 2005. PNG
experts from both CCDA and PNGFA were sent to INPE for trainings on how to use the system in
2012 and 2014. The system was modified for PNG and called TerraPNG. In 2015 a first land use
and land cover assessment was conducted by CCDA using TerraPNG and the results were made
available to the public in 2016 through the PNG REDD+ and Forest Monitoring Web-portal.
TerraPNG’s is constantly being updated by the developer (INPE) and having tools and system
enhancements, pursuing national and international approval.
PNG adopted the system because it wants to fulfil its commitment under REDD+ to Reducing
Emissions from Deforestation and Forest Degradation by monitoring Activity Data on land use and
forest change using wall-to-wall mapping.
TerraPNG is free and available for download at source website: www.terraamazon.org.
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1 INTRODUCTION TO TERRA-PNG
TerraPNG is a GIS tool designed to be a multi-user editor of geographic vectorial data.
It was developed to improve the corporate production of geographic data in order to provide an
accurate measurement of deforestation, forest degradation, land use and land cover change
and similar applications.

In TerraPNG, several users can work simultaneously on the same data following a methodology
fixed by Administrator User(s). This reduces the time of project execution and ensures that the
final data is entirely produced under the same methodology.
The spatial operations between vector data allow transitions analysis among other applications.
The system has a built-in structure to allow experienced users to audit the data produced. It
also provides reports so Project Managers can follow and analyse the evolution of the work.
The data is stored in a TerraLib model database (www.terralib.org) and is worked within a client
server environment.
Access Control and Users
TerraPNG has two user levels: Administrator and Operator. The Administrator User has full
access to all the menus and spatial operations, while the Operator User does not.
Cell Layer
Vector layer with a different type of representation: cell. TerraPNG requires the existence of a
cell layer for the Vectorial Edition through Project and for most of the spatial operations
available.
The cell layer cuts classified data in tiles, as shown in the next figure. This means that when
classifying a polygon covered by more than one cell, the polygon will be cut according to the
limit of each cell.
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Class
Classes are the attributes that will be applied to polygons through the classification process.
They can be land cover, land use, soil typology, vegetation, climate, etc.
Classification Process
Group of procedures needed to create polygons and apply them attributes through the use of
the classification tools within the edition through projects.
Database
A TerraPNG database encloses the whole set of data, either raster or vector data.
Edition Layer (or Input Layer)
Layer pointed by the theme active when opening the edition mode. Works as a draft in the
classification process of the vectorial edition through projects and is edited directly in the direct
vectorial edition. Once the user has opened the edition mode, every geometry created in it is
instantly stored in this layer. Any vector layer containing polygons representation can be used
as an input layer to the classification process until it is associated to rules or intentionally
blocked by an Administrator user for data security matters.
Edition Mode
The Edition Mode enables vectorial editions. It is opened by clicking on the icon
having an
Edition Layer active. The Main Interface changes to display the Drawing and Classification
Tools. If there is an active project, the Classification tools become functional and the
classification process is executed when triggered by one of the following tools:
or
. The
result of the classification process is stored in the Output Layer.
If there is no active project, only the Edition Layer can be edited through direct edition and its
attributes must be applied to each polygon by typing the values in the attribute pop-up
interface. In this case, the classification tools are not functional and nothing happens if they are
triggered.
Interest Area (or Area of Interest)
A spatial delimitation of a geographic area. When assigned to a project, vectorial edition can be
performed only within such area.
Layer
Vector or raster data. Every vector or raster data stored in the database is presented to the user
as a layer in the Layers Tree (see the main interface on page 7).
Vector data can have three types of representation: polygons, lines or points.
Layers are visible to all users.
2
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Output Layer
In TerraPNG interfaces you can find two different uses for the output layer term.


Vector or raster processed and saved by the TerraPNG operation, for example, creating
a buffer.



Destination layer for the resulting output of the classification process in a project.
Different classes can have different output layers. Output layers cannot be used to
access the edition mode.

Phase
A phase is a stage of the vectorial edition in a project´s execution. Through the concept of
phase, TerraPNG can keep logs of the time spent in each stage, enhancing project
management. A typical set of phases is to have a data production phase and a data verification
phase.
Project
A project identifies the set of rules that will be active in the classification process, as well as the
classes involved. Besides the procedures involved in or supporting the vectorial edition through
projects, no other procedure in TerraPNG requires the existence of a project.
Scenario
A scenario is composed by an area of interest and an observation date assigned to it. As an
example, if a certain satellite grid is used as an area of interest, then the observation date of
the image to be used must be assigned to the area of interest.
A Scenario does not attach an image to an area of interest, but an observation date.

Theme
A theme is a structure that defines which data from one particular layer will be visualized and
how it will be displayed on the screen. Themes are user-related, that is, if a user creates a
certain theme, he will be the only one able to see it, change it or remove it.
No user can see other user´s themes, not even having administrator privileges.

View
A view is a structure that defines the data that will be visualized and manipulated
simultaneously. That is, if the user needs to visualize a satellite image and a vectorial data at
the same time, both these data must be added to the same view. Views are user-related, that
is, if a user creates a certain view, he will be the only one able to see it, change it or remove it.
No user can see other user´s views, nor have administrator privileges.
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2 TERRAPNG INTERFACE
The following figure presents the main interface. It has three main areas:




Database & Layers Tree
Views & Themes Tree
Drawing Area.

MENU
TOOLBAR
DATABASE AREA

DRAWING AREA
VIEWS AND
THEMES AREA

MESSAGE BAR

The toolbar is located on the top of TerraPNG interface. It presents shortcuts to several
functions, which are described below.

Database: Creates or connects to a local or remote database
Add View: Defines the view of the user. The View will receive the
characteristics of the reference system of the first inserted data
Add Project View: Automatically adds a view that contains as themes
all the layers involved in the project “Rules”
Add Theme: Defines the visual or graphical presentation of a layer and
its spatial components
Add Multiple Theme: Adds multiple layers into a single View
Add External Theme: Enables remote access to different databases,
allowing spatial data to be imported
Vector Grouping: Customizes the visual or graphical presentation of an
attribute of interest
Add WMS Theme: Allows connecting to a WebMapService to visualize
data
Create Google Theme: Visualize Google Maps API on a Theme
Enable Project: Activates the set of rules for an existing project
Process Control: Sets and starts the analysing process for a given area
4
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Scene Reviser: Displays information on images to be reviewed
Database Tree: Activates or deactivates the database Tree
Views Tree: Activates or deactivates the Views/Themes Tree
Display: Activates or deactivates the working/draw area
Enable Full Screen: Enables Full Screen
TerraPrint: Initializes the TerraPrint plugin, used to create maps,
cartograms, charts and others
Cloud Detection: initiates Cloud Detection Plug–in.
PDI: Initializes the DIP plugin, used for digital image processing
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3 DATABASE CREATION
TerraPNG relies on database management system to store all the produced or imported
data. Therefore, the creation or connection to an existing database is a requisite.
To create the database, it is necessary to install postgreSQL (or other DBMS) on your
machine or server.
After the PostgreSQL and TerraPNG installation, click on the database button
toolbar to create the database.

of the

Operation
Click – Create
Database Type – PostgreSQL
Host – localhost (or leave it blank)
Port – 5432 (or leave it blank)
User – postgres
Password – postgres
Database Name – TerraPNG_Assessment
Encoding – Click – Get List – UTF8
Click OK

CONNECTING TO A DATABASE

To connect to an existing database, close the current active database
File » Close Database
Click – Yes

Afterwards, proceed as below:
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Toolbar » Database
Operation
Click – Connect
Database Type – PostgreSQL
Host – localhost (or leave it blank)
User – postgres (or leave it blank)
Password – postgres
Click – Select Database
Select TerraPNG_Assessment
Click OK

Note: To connect into a remote database, introduce the server IP Address on the HOST field.

The username and password must be the same one as set by administrator.
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4 CREATING THE CONCEPTUAL MODEL
The Conceptual Model structures TerraPNG edit environment. It is the central component
that allows the definition of users and its functions, projects, activities, topological rules and
spatial boundaries.
To create the Conceptual Model, follow these instructions:
Administration » Create Conceptual Model

Note: Since this operation changes the internal structure of the database, it will be

necessary to confirm the operation.
Click – Yes

In the next window you must define the name, map projection and spatial boundaries of
the workspace. The created layer will consist in a regular grid, which will define the areas to
be selected by the users.
Set the next window as follows:
Cell layer
Name – TERRAPNG_CELL
Click – Projection
Projection – LatLong
Datum – WGS 84
Parameters
Unit – DecimalDegrees (*)
Click – OK
After returning to the conceptual model configuration window, set the coordinates of the
lower left and upper right corners.
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For this assessment set as follows:
Box Information
LL (x). 140.86
UR (x). 155.97
LL (y). -11.64
UR (y). -1.36
Resolution. 0.25
Click OK

NOTE: the Resolution uses the same unit as the selected projection and defines the

Conceptual Model cell size:

Click OK
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To visualize the CELL layer created:
In the Toolbar, click:
Add View
View Name – TPNG_CM
Click – OK

To create the Theme, select the created view on the Views/Themes tree and the CELL layer
on the database tree.
In the Toolbar, click:
Add Theme
Click – OK
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To visualize the CELL layer, click on Draw
click on the Information cursor

. If you want to check the layer information,

and then click on any cell.
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5 DEFINING ACCESS CONTROL
In this step the users user_int and user_aud of the project are created and their access
to the project is defined.
Project Management » Access Control

NOTICE: Note that in the User List, there is a user called postgres already. After the

creation of the Conceptual Model, the postgres user is automatically created. This user has
administrator privileges and carries the same user name used during the creation of the
database.

Follow the steps below to include additional users:
User tab
User controller
Click – Add New User
Name – user_int
Password – 123
Click Add
Repeat the previous procedure to create the auditor user:

User tab
User controller
Click – Add New User
Name – user_aud
Password – 1234
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To remove a user:
User tab
User list
Click – user_int (User)
Click – Remove
Click – Yes
NOTICE: If the user has executed any edition, the system will not allow it to be deleted
To change the password:
User Tab

User list
Click – user_int
Click – Password

Next window:
New Password – 123456
Confirm Password – 123456
Click – OK

13

TerraPNG User’s Guide

After setting the Access Control, it is necessary to create the groups. Note that in the group
tab, there two groups already. The admGroup group and the projectManagerGroup are
automatically created during the creation of the conceptual model and holds Administrator
and Project Manager privileges respectively.
Follow the steps below to add other groups:
Group Tab
Group controller
Name – Interpreter
Click – Add

NOTICE: The group defined with operation functions only will not have access to

management and administration tools, such as:

• Rename Layer
• Change Projection
• Delete Objects from Layer
• Delete Layer
• Attribute Table Maintenance
To remove the group, follow the steps below:
Group Tab
Group List
Click – Interpreter
Click – Remove
NOTICE: If the User is associated with a group, the system will not allow its removal.
Create also an Auditor group with Operator Functions.
Now, the user needs to be associated to the group. Follow the steps below to associate
them:
User Tab x Group
Group
Select – Auditor
Users are not Member
Click – user_aud
Click –
14
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NOTICE: A user can be associated with more than one group.

Click OK
NOTICE: The association of users with groups is important to allow or not the execution of

certain tasks by a group based on its group privileges.
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6 PHASE CONTROL
In Terra PNG, a phase is a stage in the execution of a project. A stage will be associated to
a group and/or a task. To create a phase, click on:
Project Management » Phase Control

To create a phase:
New Phase
Name – INTERPRETATION
Click – Add
Click– OK success message

Phase X Group
Group – Interpreter
Click – Associate
Click – OK success message
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Click Close

Repeat the procedure above for the Auditor group.
To remove a phase, if necessary:

Phase List
Click – AUDITING
Click – Remove
Click – OK success message
Click Close
NOTICE: Phases with associated tasks cannot be removed.
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7 PROJECT MANAGEMENT
A project identifies a set of active rules in the edition process. It is possible to have more
than one project in a single database, but only one of them can be active.
To define the project, proceed as follows:
Project Management » Classification Control » Project Management

In the Project Management window:
Project
Name – PNG_PRODES
Number of locked cells – 10
Click – Add
Click – OK (success message)
Click Close

NOTICE: To remove a Project, select the Project and click on the Remove button. If the

Project contains associated rules, the system will not allow removal.
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To activate a Project, click on Activate Project button

, select the project and click on

Activate.

19

TerraPNG User’s Guide

8 CREATING LAYERS
TerraPNG allows users to create new layers using several methods.
Layer » Create Layer

To create a new layer, proceed as follows:
Creation Mode
Click – New One
Click – Next

Layer Identification tab
Name – FOREST
Author – OCCD
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Extents tab
Projection information
Click – Projection
In the projection window, proceed as follows:
Projection
Click – LatLong
Datum
Click – WGS84
Hemisphere
Click – South
Click OK

After returning to the configuration layer window:
Box Information
Click – Use an Existing layer box
Select – TERRAPNG_CELL
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Click OK
Click No

Repeat this procedure to create layers DEFORESTATION, SECONDARY FOREST,
GRASSLAND, CROPLAND, SETTLEMENT, OTHER LAND and HYDROGRAPHY.

DELETING LAYERS

This tool is used to remove one or more layers from the current database.
Administration » Delete Layers

In the interface:
Click Search
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In the data Layer Search window
List of Layers
Click – TRIAL
Click OK

After returning to the Delete Layers window, the selected files will be displayed in the List
of Layers:
Click – Delete Layers
Click – OK (Information window)
Click – Cancel

NOTICE: Remove and Remove All buttons are only selection tools to remove the

selected layers from the List of Layers to Delete.
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9 IMPORTING VECTOR DATA
Vector data can be imported from other databases or from external files. However, only the
area contained within the limits of the Conceptual Model can be edited.
File » Import Data

In the import interface, set the parameters as follows:
Import Parameters
File – C:\TerraPNG_Data\Province\png2000_prov_region_region.shp
Click – Projection
Click – OK

NOTICE: At the end of the process, the software will ask whether or not the user wants to

display the new vector in another View.

Click No
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10 RULE MANAGEMENT
A rule is defined by a spatial operation. The spatial operations that can be related to a rule
are: difference, intersection, union and clean.
For example, assume Layers A & B as input & S as output.
Difference: S=A–B; S will store all polygons or all parts of polygons in A that do not
overlap with polygons in B.

Intersection: S=A∩B results in the region of coincidence between layers A & B.

Clean: this function removes the area of the layer S which coincides with the area of the
layer A

Project Management » Classification Control » Rule Management

Two spatial operations (DIFFERENCE AND CLEAN) will be used in this TerraPNG land cover
assessment.
For the creation of rules, set the parameters as follows:
Rule Params
Rule Name – DIF_DEFORESTATION
Operation – Difference
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Layer Name – DEFORESTATION
Click – ADD (in Cell Column)
Cell Column Name
Type – cell_oid
Click – OK
Click – OK
Select – cell__oid (in Cell Column)
Click – Add

NOTICE: Repeat the procedure for the creation of the Difference and Clean rules for all

layers.
Rule Params
Rule Name – CLEAN_DEFORESTATION
Operation – Clean
Layer Name – DEFORESTATION
Select – cell_oid (in Cell Column)
Click – Add
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Click Close
NOTICE: The creation of the cell_oid column is only necessary when this field does not

exist in the layer’s attribute table.
To remove a rule, select it and click Remove. After removal, a message will be displayed
with the status of the operation.
Click OK.
NOTICE: The rules cannot be changed or deleted after its association to a project.
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11 CLASSES MANAGEMENT
Classes in TerraPNG are defined for the whole database and can be associated to any
project.
Project Management » Classification Control » Class Management

To create a class, follow the steps below:
Class tab

Class
Name – DEFORESTATION
Click – Add
Click – OK (Information window)

Click Close

Repeat the procedure for the other classes (forest, secondary forest, grassland, cropland,
settlement, hydrography and other land).
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12 RULES CONTROL
The rule control defines relations between projects, rules and classes. Therefore, the
operations related to the creation of the structure of the project must have been executed
previously.
Below are the descriptions of the fields displayed in Rules Control:
1. Project: presents the list of projects defined in the database.
2. Set of rules: area where rules and output layer will be associated.
3. Select Output Layer: selects the layer to be used as Output.
4. Output Layer List: lists the layers selected as Outputs.
*Note each output layer MUST be validated separately
5. Rules: use this tab to associate a spatial rule with a specific Output.
6. Attributes: this tab associates the layer attributes with the rules included in Rules tab
(previous tab).
7. Class List: presents all classes defined in the database and allows their association with
an output. It demands the creation of an attribute column to record classes.
8. Clean: presents the clean rules defined in the database, allowing its association with an
Output.
9. Validate: This option validates all the information created for the project, such as rules,
associations, classes, destination layers, representations of polygons. To make use of the
entire structure created, it is necessary to click on the validate button for each output of the
Output Layer List.
Project Management » Classification Control » Rules Control

To control the edition rules, follow the steps below:
Project – PNG_PRODES
Select Output Layer
Click – Manager Layers
Click – Layer
Select – DEFORESTATION
30
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Click – Ok

Click – ADD (if cell_oid does not appear in the drop–down menu)
Type – cell_oid
Click – OK
Click – OK
Click – Add
Click – OK
Select Output Layer
Click –
(To associate the layer with the project in Output Layer List)
Rules tab
All Rules
Click –
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Output Layer List
Click – DEFORESTATION
Class Columns tab
Column
Click – Add column
In the window create new class column:
Type – class name
Click – OK
Click – OK (information window)

After returning to the previous window:
Class List tab
Click– DEFORESTATION
Click–
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Repeat the procedure for the other layers.
Output Layer List
Click – DEFORESTATION
Clean tab
All Rules
Click – CLEAN_DEFORESTATION
Click –

Repeat the procedure for the other layers.

Click – Validate (the validation must be done for each layer separately)
Click – OK (Indexes information window)
Click – OK (Information window)

Click – Close
33
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13 DEFINING AN AREA OF INTEREST
An Area of Interest (AI) defines the spatial boundaries of a geographic region. The AI
layer ensures that all input geometry will be contained within it; therefore, any
information outside the AI will be discarded during the classification process.
Project Management » Interest Area

Import the boundaries contained in a vector file as follows:
Layer

Click – Add
Select – png2000_prov_region_region
Click – Ok
Click – Add
Select – CENTRAL (should choose your own area/province of interest)
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Parameters
Type – 09/12/2015 (put your current date)
Click – Add
Click – OK

Click – Next

NOTICE: A scenario consists of an Area of Interest and a date of observation.

The next window shows all scenarios included in the database,

Click – Next
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To change the date of a scenario, select the scenario and click on the Update button.
Change the date and click on Update to confirm the modification.

In the Project association:
Project

Click – PNG_PRODES
Click – Set
Click – Finish
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You can lock a scenario for the selected project to prevent other users from accessing it.
Select a scenario to lock and click on Locked.

NOTICE: After defining the DB environment, the images that will be interpreted will be

imported.
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14 RASTER COMPOSITION
Click PDI Plugin
Image Processing » Functions » Raster Composition

Notice: The order of the imported images indicates the sequence for the colour

composition. The first will be applied to the red channel, the second to the green
channel and the third to the blue channel.

Input Parameters
From File tab
Click – File – C:\ TerraPNG_Data\ AGP\ S10E148_2014_L8
– S10E148_2014_L8_Band_6
– S10E148_2014_L8_Band_5
– S10E148_2014_L8_Band_4

Geographical Parameters
Projection – LatLong/WGS84
Storage Parameters
Layer Name – S10E148_2014_L8_654
Compression – ZLIB
Dummy – 0
Levels – 5
Click – OK
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Click – No
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IMPORT RASTER

Return to the main interface of TerraAmazon.
File » Import Raster

Data Characteristics
Click – File
C:\ TerraPNG_Data\First_Analysis_Export\ S10E148_2014_L8_654
Dummy – 0

Click – Next
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Geographical Parameters
Projection – LatLong/WGS84

Click – Next
Storage Characteristics
Layer

Compression – ZLIB

Tiling
Dummy – 0
Import Options
Click – Change Edge Dummy Value – 0
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Click – Next
Multi Resolution Characteristics
Number of Levels – 5
Multi Resolution Method – Lower Resolution
Click – Finish

Click – No

42

TerraPNG User’s Guide

15 CREATING VIEWS AND THEMES
Create a View for the image to be classified.
Toolbar » Add View
– Interpretation

To create a Theme, select the View Interpretation created in the area of
Views/Themes and select the layer S10E148_2014_L8_654 in the database area.
In the toolbar
Click – Add Theme
Unselect – Set Scale (if selected)
Click – OK
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16 SEGMENTATION
The segmentation is the process of partitioning a digital image into multiple segments
(sets of pixels). The goal of segmentation is to simplify and/or change the
representation of an image into something that is more meaningful and easier to
analyse.

Click PDI Plugin
Image Processing » Segmentation

Set the segmentation window as follows:
Input Parameters
Raster Image – S10E148_2014_L8_654
Type – Baatz

Configuration Parameters
Scale – 20
Compactness – 0.5
Colour – 0.5

Output Parameters
Layer Name – S10E148_2014_L8_654_seg

Click OK
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NOTE: The segmentation process requires large quantities of memory.
Click – No

To visualize the outcome of the segmentation:
Close the PDI plug–in.
Add the Segmented layer in the Interpretation view
Draw the Theme
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17 ADDING TASKS AND ACTIVATE PROCESS
A task defines the interest area to be edited as well as the user responsible for it.
Toolbar » PROCESS CONTROL
Click – Add New Task

Phase
Select – INTERPRETATION
Click – List
Click – 1
Click – Add
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Click – OK

Click – Close

Click – 1
Click – Start Process
Click – Close

48

TerraPNG User’s Guide

18 MANUAL EDITION
To start the manual edition, add the segmented layer to the Interpretation view which
contains the layer (S10E148_2014_L8_654) to be edited.
Select the Segmented layer and enable the edition mode.
VIEW BAR » ENABLE LAYER EDITION
NOTE: By clicking on the Enable Layer Edition tool, the Application, Configuration

and Editing Toolbars are automatically enabled.
APPLICATION TOOLBAR

Save: Saves the modifications to the layer
Cancel All Edition: Removes all unfinished edition
Undo: Removes the last added node
Redo: Inserts the last removed node

CONFIGURATION TOOLBAR

Digitalization Step – mm: Sets the minimum interval between
the vertex on the continuous vector mode
Turns Snap On: Enables snapping the cursor to the nearest
existing node.
View Cells: Enables visualizing cells in use by other users
Classes of the Project: Determines the output class of an edited
or reclassified polygon.

EDITING TOOLBAR
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Select Geometries: Selects individual geometries created on the
edition layer
Select by Drawing Area: Selects geometries based on the drawing
area
Select Cell: Selects for edition individual cells from the conceptual
model
Select Cells in Box: Automatically chooses the cells to be edited
based on the project configuration
Unselect All Cells: Deselects all cells
Create Polygon: Creates a polygon based on vertex–by–vertex
mode
Continuous Polygon: : Creates a polygon based on streaming
mode
Move: Moves selected geometries
Delete: Deletes selected geometries
Clear Current Class: Clears only the chosen classification for a set
of selected polygons
Clear Classification: Removes all classifications from a set of
selected polygons
Select Multi Layer: Selects individual geometries created on the
classification layer
Select Area Multi Layer: Selects classified geometries, based on
the drawing area
Classify: Classifies the selected geometries
Reclassify: Modifies polygon classifications
Draw Reference Rect: Exhibits a 6.25ha square to be used as
reference.
Insert Vertex: Add vertices to a polygon under edition
Move Vertex: Move vertices of a polygon under edition
Delete Vertex: Delete vertices of a polygon under edition
Aggregate Area: Aggregate area to a polygon under edition
Remove Area: Removes polygons areas
Unite Polygons: Unite polygons
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EDITION TOOLBAR » CLICK ON SELECT CELL
Click on the cells of interest.

EDITING TOOLBAR » CLICK ON SELECT CELL
By clicking again on the tool

, the cells will appear as shown below:
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NOTE: Due to TerraPNG multi–user environment, layers are only enabled for edition

after cells are selected. For an active user, cells will appear in green. Cells selected by
others will be shown in red and cannot be selected.
To edit the segmented layer, proceed as follows:
EDITING TOOLBAR » Select geometries
Zoom into a segment and click on it to select it. You can now classify the segment.

To classify the feature choose the class

and click Classify
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Repeat the procedure for the remaining classes until the whole image is
classified.
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